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SYSTEM REQUIREMENTS 
Operating System 

Your computer must have Microsoft Windows 95, Microsoft Windows 98, or 
Microsoft Windows NT 4.0, or higher versions of these operating systems. 

Disk Space 

This program requires approximately 65 megabytes of space on your hard 
drive.  

Hardware 

 A mouse or pointing device is required.  

  A CD-ROM reader is required to use the program.  

 To access our web site you must have a modem and a connection to 
the Internet. 

 In order to hear sounds you must have a sound card and speakers. 
Note: SOUND IS NOT REQUIRED TO USE ALL OF THE PROGRAM’S 
FEATURES.  INCIDENTAL MUSIC ONLY IS PLAYED. 

INSTALLATION INSTRUCTIONS 
USING WINDOWS 95, WINDOWS 98, OR WINDOWS NT 4.0 

1.   Place the CD into your CD-ROM drive. 

2.  In the start-up screen click on START, then click on RUN. 

3.   Type in D:\CDSETUP and press Enter. (If your CD-ROM drive is not D, 
then change it to the letter associated with your CD-ROM drive.) 

4. Follow any instructions that appear on the screen. 
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WELCOME   
Launching the Program 

To launch the program, click on the Start button, select Programs, and then select the 
Card Games icon. The main program will open and load the default Card Games 
image.  

BRIDGE  
Introduction 

Please see the online help for information on the rules and strategy of Bridge. 

FILE MENU 

Exit 

To close the game of Bridge, select Exit from the File menu.  

PLAY MENU 

Rubber 

This function begins a new game of bridge using Rubber scoring.  For more information 
on Rubber scoring, refer to the online help documentation.   

Saved Hand 

This function plays a previously saved hand.  You are prompted for the name of the file.  
You can create a saved hand by ‘Entering a Hand’ or by ‘Saving a Hand.’ 

PLAY SPECIAL HAND MENU 
Refer to the online help documentation for a detailed explanation of the features 
provided in the Play Special Hand Menu. 

ENTERING HANDS 
Entering a hand allows you to decide which cards are placed in which hands.  If you 
want to see how to play a certain hand, you can enter it and then choose Saved Hand 
from the Play menu.  For a more detailed explanation of entering hands, refer to the 
online help documentation.  

EDITING HANDS 
Editing allows you to modify a previously saved hand.  This can be a hand entered or 
saved during game play by choosing Save from the Hand menu.  You will be prompted 
for the name of the hand to edit.  Once selected, you will be told the description of the 
file.  For a detailed explanation of editing and saving hands, refer to the online help 
documentation. 

PRINTING HANDS 
Print out the current hand to the default printer.  The hand of all four players is printed.  
Note that this feature is disabled during network or modem play. 
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MULTIPLAYER OPTION 
The Multiplayer option allows more than one person to play Bridge on the same 
computer.  Detailed information on the Multiplayer option is provided in the online help 
documentation. 

DISPLAY ORDER 
The Display Order function allows you to set the order in which the cards are displayed.  
Refer to the online help manual for a list of the Display Options from which you may 
choose. 

DISPLAY SIZE 
Allows you to set the display area used by the game.  Choose from one of the three 
following options: 640x480, 800x600 or 1024x768.  (Note: your Windows display 
settings must be at least 640x480 to see the entire play area.) 

KIBITZ 
For learning and practice purposes only, you can choose which hands to reveal (or to 
kibitz). To toggle kibitzing, click on the card next to the side you wish to change.  The 
card back will be displayed if the hand is not to be revealed, and the Ace of Spades will 
be displayed if that side is to always be revealed. 

Background and Event Music 

Refer to the online documentation regarding background and event music.   

Save Hand 

Saves the current hand to a file.  You must enter the name of the file to save it to.  Next, 
enter a brief description of the hand.  Later, you can play the hand again by choosing 
Saved Hand from the Play menu on the title screen. 

Hint 

If you are bidding, selecting Hint gives you the suggested bid that you should make.  If 
you are playing, it gives you a suggested card to play.  A Hint also places the cursor over 
the suggested card for you.  You can also obtain a Hint by pressing the right mouse 
button. 

Connect Modem 

Connect NETBIOS 

Listen Modem 

Listen NETBIOS 

Video/AUDIO Troubleshooting 

For the topics listed above, please see the online help for complete details. 
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Multiplayer Support 

There are two types of players during the multiplayer support.  One of these players is 
the dealer who will deal the first hand and decide what the scoring method will be and 
the rest of the players are nondealers. 

For more detailed information regarding multiplayer support, refer to the online help 
manual. 

Colors 

Change the number of colors used for display.  Choose between 16-color artwork and 
256-color artwork. 

TCP/IP - Connect 

Direct Connection - Connect 

Direct Connection - Listen 

TCP/IP – Listen 

For the topics listed above, please see the online help for details. 

Quit Session 

Quits the current game.  This will return you back to the Bridge title screen. 

Playing Bridge Over the Internet 

Bridge can be played by up to four people over an Internet connection.  For detailed 
information on how you can play Bridge over the Internet, refer to the online help 
documentation. 

CANFIELD SOLITAIRE  
How To Use This Software 

MENU OPTIONS 
Most features are accessed through the "File..." menu.   

• The "New" menu option causes a new game to be started and the cards to be 
shuffled and dealt. 

• The "Undo" menu option allows the player to take back and change a move. 

• The "Options" menu item allows the player to customize the game environment, 
such as the animation speed and color schemes.  Note that selecting the fastest 
animation speed effectively disables animation, which is useful for improving 
performance on slower machines. 

• The "Quit" menu option ends the current game, but leaves the software running so 
that a new game can be played. 

MOVING CARDS 
There are several ways to move cards in this game.  Most players use a combination of 
techniques.  Please feel free to use those features that seem most comfortable. 
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Drag and Drop.  This game supports visual dragging and dropping of cards.  Just click 
on a card and while holding the left mouse button, drag the card to where it should be 
placed, then let go.  If the move is valid, the card will be dropped into that area. 

Point and Click.  As an alternative to drag and drop, click once on a playable card and 
let go.  The card will turn gray to show that it's selected.  Move the mouse to where the 
card should be moved.  If that is a valid move, the mouse cursor will change to a vertical 
arrow.  Click once on that spot and the selected card will be moved. 

Double Clicking.  Double clicking upon a tableau or reserve card will automatically 
send the card up to the appropriate foundation if there is a foundation move to be made 
with that card.  When a game is not active, double clicking anywhere on the background 
causes a new game to be dealt. 

Rules 

THE LAYOUT 
The reserve area is located at the top left corner of the screen.  To the right of the 
reserve area are four foundations.  The tableau is located below the foundations. After 
dealing four cards to the tableau, and one card to the first foundation, the remaining 
cards will be placed in the reserve area at the top left corner of the screen. 

THE OBJECT OF THE GAME 
The object is to build the foundation cards into four complete suits of thirteen cards 
each. 

VALID MOVES 
Build upon cards in the tableau downward in alternating colors (i.e., move a red 5 onto 
a black 6). Any or all cards in a pile located in the tableau may be moved as a unit. 
Build upon the foundations in incrementing order, by suit (i.e., play 2 of Spades on the 
Ace of Spades in the foundation). Reserve cards can be played on the foundation or 
tableau cards as needed. The top card of the waste pile is always available to be played. 
As spaces open up in the tableau, continue to fill them with cards from the reserve.  
When these are exhausted, fill them with cards from the hand or the waste pile. 

WINNING THE GAME 
The game is won when all the cards have been moved to the foundations.  See the help 
file for strategy tips. 

CRIBBAGE 
How To Use This Software 

The objective of Cribbage is to be the first player to score 121 points.  For detailed 
information on how to play Cribbage, refer to the online manual.  

MENU OPTIONS 

New 

To play a new game of Cribbage, choose the Game menu, and select New.  You will be 
prompted to choose a partner (if you are utilizing team play) and your opponents.  Select 
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your opponent’s skill level from the three provided: beginners, intermediates, or 
experts.  The experts will play the most challenging game. 

Open 

This function plays a game of Cribbage that you previously saved to disk.  The Rule 
Options will be displayed to show you what the rules are.  This dialog is read only.  You 
play with the rules that were set when the game was saved, not the current rule options. 

CHANGE RULES 

Team Play 

When this option is set, there are two partnerships (teams), each with two players.  
When the option is not set, two players compete against one another. 

Score 

You must decide the length of the game by selecting the winning point total.  The 
choices are 61 points or 121 points. 

First Deal 

There are two choices available for the first deal.  The first choice is Always Cut.  
Before every game, the players will cut for the first deal.  The player cutting the lowest 
card gets to deal first.  The second option is Loser.  The players will cut for first deal for 
the first game.  Then for all following games, the loser will always get the first deal. 

Scoring 

Refer to the online help documentation for more information on scoring. 

Records 

Records keep track of your wins and losses, as well as that of your opponent's.   

Save 

This function entitles the player to continue the game he/she is in the process of playing 
by saving it onto a disk.   

Close 

This function ends a game immediately.  You will be prompted to save the game.  
Choose yes to save the game to a file, no to quit without saving, or cancel to return to 
the game.  After closing, you will return to the title screen. 

Exit 

This function exits Cribbage.  If a game is in progress, you will be prompted to save the 
game before exiting. 

OPTIONS MENU 
For detailed information on the functions provided under the Options menu, refer to the 
online help documentation.   
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VIEW MENU 
For detailed information on the functions provided in the View menu, refer to the online 
help documentation. 

MULTIPLAYER MENU 
The Internet/TCP/IP and direct modem play are explained in the online help and are 
similar to Bridge.   

EUCHRE  
How to Play 

To start a new game of Euchre, choose the Game menu, then choose New.   

Game Menu 

New 

To begin a new game of Euchre, you will be prompted to choose a partner (if you are 
utilizing team play) and your opponents.  There are three skill levels to choose from: 
beginners, intermediates, and experts. For the most challenging game, choose experts. 

Open 

Choose this option to play a game of Euchre that you previously saved to disk.  The rule 
options show the saved rules.  

Save 

This entitles the player to continue the game he/she is in the process of playing by 
saving it onto a disk. 

Quit 

Choose Quit to end a game immediately.   

RULES 
Refer to the online help documentation for detailed information on the rules, bidding 
and scoring of Euchre.  

Options and Multiplayer Menus 

Refer to the online help documentation for detailed information on the functions of the 
Options and Multiplayer menus. 

FRIDAY THE 13TH SOLITAIRE 
To play this game, you may use the same commands used in Canfield. Please see the 
information on Canfield for more details. 

THE LAYOUT 
There are 13 foundations located in two rows across the top of the screen.  The 
foundations range from the Jack through the 10.  When beginning a new game, a Jack, 
Queen, King, and Ace are dealt to the first four foundations, respectively. The 
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remainder of the deck is located below the foundations.  Cards are turned over one at a 
time to be played.  Once all of the cards have been played, one more redeal is allowed. 

THE OBJECT OF THE GAME 
The object is to build upon the foundation cards in such a way as to play all cards, and 
build at least one card on every foundation. 

VALID MOVES 
Each empty foundation is labeled with a number, ranging in order from Jack through 10.  
The first card to be played to an empty foundation must match the rank labeled on the 
empty foundation. Cards are turned over from the hand one at a time.  If the card cannot 
be played, it should be moved over to the adjacent waste pile.  The top card on the 
waste pile can be played at any time.  Build upon cards on the foundations upwards 
regardless of suit (i.e., move any 5 onto any 4). A card can be played to an empty 
foundation only if all foundations of a lower rank (foundations to the left) are already 
filled with at least one card.  For example, at the beginning of the game, a 2 card can be 
played onto the 2 foundation because all foundations to the left (the Jack, Queen, King, 
and Ace) are already filled.  A 4 card could not be played onto the 4 foundation until the 
2 and 3 foundations are filled with at least one card each. 

WINNING THE GAME 
The game is won when all of the cards have been moved to the foundations, and all of 
the foundations are filled with at least one card, before the cards run out on the second 
re-deal. 

FROG SOLITAIRE 
To play this game, you may use the same commands used in Canfield.  Please see the 
information on Canfield for more details. 

THE LAYOUT 
Thirteen cards are dealt and placed in the reserve area located to the left of the waste 
piles.  If the reserve cards contain any aces, they are automatically placed into the 
foundation. The foundation is made up of the eight aces.  They are placed in a single 
row at the top of the screen above the waste piles.  There are five waste piles located 
below the foundation and to the right of the reserve. 

THE OBJECT OF THE GAME 
The object is to place all of the cards from the reserve and waste piles into the 
foundations in incremental order beginning with aces. 

VALID MOVES 
The aces are placed into the foundation as they are made available from the hand. Cards 
from the hand are turned up one at a time.  If the card cannot be played onto the 
foundations, it is placed in any one of the five waste piles.  As many or as few cards 
may be put in one waste pile.  Placement of the cards into the waste piles is very 
important. Build upon the foundations in incrementing order (i.e., three on two, two on 
an Ace, etc.) regardless of suit. Reserve cards should be played on the foundations as 
soon as they are available for play.  Reserve cards cannot be played on the waste piles. 
Thirteen cards are dealt and placed in the reserve area located to the left of the waste 
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piles.  If the reserve cards contain any aces they are automatically placed into the 
foundation. The foundation is made up of the eight aces.  They are placed in a single 
row at the top of the screen above the waste piles.  There are five waste piles located 
below the foundation and to the right of the reserve. 

GOLF SOLITAIRE 
To play this game, you may use the same commands used in Canfield. Please see the 
information on Canfield for more details. 

THE LAYOUT 
Five rows of cards are dealt face up.  Each row contains seven cards, which overlap.  
These cards are called the tableau.  The tableau is comprised of 35 cards. After dealing 
cards to the tableau, the rest of the deck, or hand is placed at the top left corner of the 
screen.  One card is turned face up to begin the waste pile. 

THE OBJECT OF THE GAME 
 The object is to clear away the entire tableau by building the cards upon the waste pile. 

VALID MOVES 
The bottom cards of the tableau columns may be removed and placed on the waste pile 
if it is in sequence, either up or down, regardless of suit. A series of cards may be 
played from the tableau to the waste pile in one turn.  For example: the top card of the 
waste pile is a 5.  This may be built; 6, 7, 6, 5, 4, 3, etc. The sequence of rank is not 
continuous, only a two may be placed on an ace, and a king stops the sequence (no card 
may be played on a king). 

WINNING THE GAME 
The game is won when the tableau is completely cleared. Another way of scoring is to 
compete against "par."  One game of Golf is treated as a "hole."  The number of 
"strokes" taken by the player to make this hole is the number of cards left in the tableau 
after play is blocked.  A hole may be completed with a score of less than zero.  If the 
game is won, the number of undealt cards remaining in the hand is a minus score.  Play 
nine holes and total the scores.  You beat par if your total is thirty-six or less. 

HEARTS 
The game of Hearts is played without the use of partnerships.  Your objective is to 
avoid winning any tricks that have Hearts or the Queen of Spades.  

How to Play 

To play a new game of Hearts, choose Start a New Game from the Game menu.  You 
will be prompted to choose your opponents.  Their skill levels are listed at the top of the 
dialog.  For the most challenging game, choose the experts. The first hand will then be 
dealt.  For detailed rules on how to play Hearts, refer to the online help documentation. 

Save 

Selecting Save entitles the player to continue the game he/she is in the process of 
playing by saving it onto a disk.   
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Exit 

Selecting Exit will immediately end the game in progress.  You will be prompted to 
save the game.  Choose yes to save the game to a file.  Choose no to quit without saving 
or choose cancel to return to the game.   

Options Menu 

For detailed information on the functions of the Options and Multiplayer Menus, refer 
to the online help manual. 

KING ALBERT SOLITAIRE 
Rules For Playing This Game 

To play this game, you may use the same commands used in Canfield. Please see the 
information on Canfield for more details. 

THE LAYOUT 
Nine rows of cards are dealt face up.  The first row contains nine cards.  Each 
subsequent row contains one less card than the previous row.  These cards are called the 
"tableau."  The tableau looks much like the popular "Klondike" solitaire game except 
that there are more rows, and all of the cards are dealt face up. After dealing cards to 
the tableau, the seven remaining cards will be placed in the "reserve" area at the top left 
corner of the screen. To the right of the reserve area are four "foundations." 

THE OBJECT OF THE GAME 
The object is to release the Aces from the tableau and reserve areas and build them 
upon the foundations, in numerical sequence and in suit, up to Kings. 

VALID MOVES 
Unlike traditional "Klondike" Solitaire, only one card may be moved at a time.  Only 
the last, fully exposed card in each tableau column can be moved or played upon. Build 
upon cards in the tableau downward in alternating colors (i.e., move a red 5 onto a black 
4). Build upon the foundations in incrementing order, by suit (i.e., play 2 of Spades on 
the Ace of Spades in the foundation). Reserve cards can be played on foundation or 
tableau cards as needed. Empty columns may be left empty or filled with any card.  (See 
the tips for hints on utilizing empty column spaces.) 

WINNING THE GAME 
The game is won when all 52 cards have been moved up to the foundations and the four 
foundations have all been built from Aces up to Kings. 

KLONDIKE SOLITAIRE 
Rules For Playing This Game 

To play this game, you may use the same commands used in Canfield. Please see the 
information on Canfield for more details. 

THE LAYOUT 
The tableau is comprised of seven piles increasing in number from one to seven cards, 
with the top card of each pile face up and the rest face down.  The tableau contains 28 
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cards. After dealing cards to the tableau, the rest of the deck is the hand, which is 
placed at the top left corner of the screen.  Cards from the hand are turned face up.  This 
forms the waste pile. 

THE OBJECT OF THE GAME 
The object of the game is to clear away all the cards by building them into four suits in 
the foundation. 

VALID MOVES 
The top cards of the tableau columns are built down in alternating colors (i.e., black ten 
may be placed on red jack). Cards in the tableau may be built onto each other.  When a 
face down card in the tableau is exposed, the card is turned up and made available for 
play. Top cards in the tableau are available for play on the foundations.  Aces must be 
moved to the foundations as soon as they are made available.  Any higher card may be 
kept on the tableau for building purposes, if the player wishes, rather than built on the 
foundations.  A space in the tableau, by removal of an entire pile, may be filled only by 
a king. A series of cards may be played from the waste pile to the foundations or the 
tableau in one turn. 

WINNING THE GAME 
The game is won when all the cards have been placed onto the foundations. 

PYRAMID SOLITAIRE 
Rules For Playing This Game 

To play this game, you may use the same commands used in Canfield. Please see the 
information on Canfield for more details. 

THE LAYOUT 
Twenty cards are dealt face up and placed in the shape of a pyramid.  These cards are 
called the tableau. After dealing cards to the tableau, the remaining cards form the 
hand. The hand is placed to the left of the tableau. The waste pile is located below the 
hand. 

THE OBJECT OF THE GAME 
The object is to clear away the entire tableau and waste pile by adding the cards to 
equal thirteen (13). 

VALID MOVES 
From available cards, remove and discard all kings singly, and all other cards in pairs 
that total thirteen. Cards from the hand are turned face up one at a time.  These cards 
can be played either on the tableau or the waste pile.  If the card is unplayable at the 
time, it is placed face up in the waste pile. 

WINNING THE GAME 
The game is won when all of the cards from the waste pile and tableau have been built 
into pairs of thirteen. 

SPADES 
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How to Play 

To start a new game of Spades, choose New from the Game menu.  You will be 
prompted to choose your partner (if there is team play) and your opponents.  Their skill 
levels are listed at the top of the dialog.  The first hand will then be dealt.  You will be 
prompted for your bid.  See Rules for more information on bidding in the online help 
manual. 

Main Menu 

Refer to the online help documentation for a complete description of all the Main Menu 
functions.   

EXIT 
To end the game of Spades, select Exit from the File Menu. 

NEW 
To begin a new game of Spades, select New from the Game Menu.   

OPEN 
To play a game of Spades that you previously saved to disk, select Open in the Game 
Menu.  The rule options will be displayed to show you what the rules are.  This dialog 
is read only.  You play with the rules that were set when the game was saved, not the 
current rule options. 

RULES 
For detailed information on rules, scoring, and bidding, refer to the online help 
documentation. 

OPTIONS MENU 
For detailed information on all of the functions provided in the Options Menu 
(animation, changing players, backgrounds, text color, card backs, music and sound 
effects), refer to the online help documentation. 

GAME MENU 
Refer to the online help documentation for information on the functions provided in the 
Game Menu. 

MULTIPLAYER MENU 
For detailed information on all of the functions provided in the Multiplayer Menu, refer 
to the online help documentation. 

VANISHING CROSS SOLITAIRE 
To play this game, you may use the same commands used in Canfield. Please see the 
information on Canfield for more details. 

THE LAYOUT 
Five cards are dealt face up and placed in the shape of a cross.  These cards are called 
the tableau. After dealing cards to the tableau, one card is placed in the upper left-hand 
corner of the cross to form the foundation.  The other foundations must be the same rank 
as the corner card and should be placed in the other corners, as they become available. 
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The hand is placed to the left of the tableau and foundations.  The waste pile is located 
below the hand 

THE OBJECT OF THE GAME 
The object is to clear away the entire tableau by building the cards upon the 
foundations, therefore creating a "Vanishing Cross." 

VALID MOVES 
Cards from the hand are turned face up one at a time.  These cards can be played either 
on the foundations or the tableau.  If the card is unplayable at the time, it is placed in 
the waste pile. Cards may be built onto the tableau in descending order regardless of 
suit.  The tableau cards may be built onto each other.  Only one card at a time may be 
moved from the top of a pile.  Spaces may be filled by available cards from the tableau, 
waste pile or the hand.  The top cards in the tableau are always available for play onto 
the foundations. The foundations are to be built up in suit until each pile has thirteen 
cards, aces following kings. 

WINNING THE GAME 
The game is won when all of the cards have been built into the corners by suit. Please 
see the game's help file for strategy tips. 
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SUPPORT 
We encourage all of our users to provide comments and suggestions about this program.  
This program is supported by voice, fax and Internet e-mail. 

Voice and Fax 

For telephone support, call COSMI’s Customer Service at (310) 886-3510 during the 
hours below.  (Note:  All times are in the Pacific Standard Time zone.)  You may fax us 
at (310) 886-3517. 

Monday through Thursday, 8:30 am - 12:00 noon and 1:00 pm - 4:00 pm 

Friday, 8:30 am – 12:00 noon. 

⌦ COSMI is very proud to be one of the few remaining software publishers to provide 
no charge customer support! 

E-mail 

Support questions may be addressed to: support@cosmi.com. 

Internet 

Be sure to visit COSMI’s Internet Web site: http://www.cosmi.com.  



PROGRAM DESCRIPTION 

The best value in card games! Play all of your favorite card games: Bridge, 
Cribbage, Euchre, Hearts, Spades and special bonus Solitaires. This 
extraordinary value will give you hours and hours of fun and great card game 
play. You’ll be challenged by tough cyber opponents or play against anyone in 
the world through optional Internet, modem or computer network connections. 
This multiple award winning card game collection combines great opponents 
with the best computer play. An essential suite of programs for anyone who 
likes card games. 

Card Games is © 1998 by COSMI Corporation. All rights are reserved 
worldwide. Copying without the permission of COSMI is expressly prohibited 
except for the purpose of making one working copy for your own personal use. 
Contact COSMI for licensing arrangements. 

WARRANTY 

COSMI makes no warranty of any kind, express or implied, including 
without limitation any warranties of merchantability and/or fitness for a 
particular purpose.  COSMI shall not be liable for any damages, whether 
direct, indirect, special or consequential arising from a failure of this 
program to operate in the manner desired by the user.  COSMI shall not be 
liable for any damage to data or property that may be caused directly or 
indirectly by use of this program. 

The disk on which this software is recorded will be replaced within 90 days of 
purchase if found to be defective in material or workmanship.  This shall 
constitute the sole remedy of purchaser and the sole liability of COSMI 
Corporation. 

IN NO EVENT WILL COSMI BE LIABLE FOR ANY DAMAGES, 
INCLUDING ANY LOST PROFITS, LOST SAVINGS OR OTHER 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF 
YOUR USE OR INABILITY TO USE THE PROGRAM, OR FOR ANY 
CLAIM BY ANY OTHER PARTY. 

The License Agreement and Warranty shall be construed, interpreted and 
governed by the laws of the state of California. 

COSMI CORPORATION 

2600 Homestead Place 

Rancho Dominguez, CA  90220 

voice (310) 886-3510 

fax (310) 886-3517 

COSMI EUROPE, LTD. 
8A Daimler Close 

Royal Oak Industrial Estate 
Daventry, Northamptonshire 
NN11 5QJ, United Kingdom 

voice +44(0) 1327 879000 
fax +44 (0) 1327 879888

E-mail:  support@cosmi.com 
Internet Web site: http://www.cosmi.com 


